
Chapter 1: Entering, Editing,
and Formatting Text

In This Chapter
� Creating new documents

� Opening documents

� Saving versions of documents

� Changing text fonts and the size of text

� Spell-checking a document

Chapter 1 is where you get your feet wet. Don’t be shy. Walk right to the
shore and sink your toes in the water. Don’t worry; I won’t push you

from behind. This chapter explains how to create and open documents, save
different versions of documents, and change the look of the text. For poor
typists and spellers, it also tells how to spell-check a document.

Getting Acquainted with Word
Seeing the Word screen for the first time is sort of like trying to find your way
through Tokyo’s busy Ikebukuro subway station. It’s intimidating. But when
you start using Word, you quickly learn what everything is. To help you get
going, Table 1-1 gives you some shorthand descriptions of the different parts
of the Word screen. Figure 1-1 shows precisely where these screen parts are.

Table 1-1 Parts of the Word Screen
Part of Screen What It Is

Title bar At the top of the screen, the title bar tells you the name of 
the document you’re working on.

Control menu Click here to pull down a menu with options for minimizing,
maximizing, moving, and closing the window.

Minimize, Restore, These three magic buttons make it very easy to shrink, 
Close buttons enlarge, and close the window you are working in.

Menu bar The list of menu options, from File to Help, that you choose 
from to give commands.

(continued)
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Table 1-1  (continued)
Part of Screen What It Is

Task Pane The pane that appears on the right side of the screen and 
provides options for opening Word documents and doing 
other tasks. 

Toolbars A collection of buttons you click to execute commands. To 
display or remove toolbars, right-click a toolbar and 
choose a toolbar name on the shortcut menu.

Scroll bars The scroll bars help you get from place to place 
in a document.

View buttons Click one of these to change your view of a document.

Status bar The status bar gives you basic information about where 
you are and what you’re doing in a document. It tells you 
what page and what section you’re in, the total number of 
pages in the document, and where the insertion point is on
the page.

To see the Standard toolbar and Formatting toolbar in two separate rows,
click the Toolbar Options button and choose Show Buttons on Two Rows.
You will find the miniscule Toolbar Options button on the far right side of
the Standard or Formatting toolbar.

Toolbars

View buttons

Control menu Title bar

Menu bar

Minimize, Restore, Close buttons

Status bar Scroll bars

Figure 1-1:
The Word
screen.
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Creating a New Document
Document is just a fancy word for a letter, report, announcement, or procla-
mation that you create with Word. When you first start Word, you see a doc-
ument with the generic name “Document1.” Apart from the new document
that appears when you start Word, the program offers a bunch of ways to
create a brand-new document:

✦ Starting from a blank document: Click the New Blank Document
button, press Ctrl+N, or click the Blank Document hyperlink in the New
Document task pane. Go this route and you get a blank document made
from the Normal template. For most occasions, the blank document is a
fine place to start.

✦ Starting with a sophisticated template: Click the On My Computer
hyperlink in the New Document task pane to open the Templates dialog
box and choose a template there, as shown in Figure 1-2. You’ll find the
On My Computer hyperlink under the “Other Templates” in the New
Document task pane. If you don’t see the task pane, press Ctrl+F1 or
choose View➪Task Pane.

Select a tab in the dialog box, select a template or wizard, and click the
OK button. Each template comes with its own sophisticated styles so
that you don’t have to create fancy layouts yourself (Chapter 4 explains
styles). A wizard is a series of dialog boxes in which you make choices
about the kind of document you want. If you are in the market for a fancy
document, you can save a lot of time by doing it with a template or wizard
because you don’t have to do most of the formatting yourself.

Figure 1-2:
The
Templates
dialog box.

04 Bk01Ch01.qxd  9/3/03  9:19 AM  Page 9



Speedy Ways to Open Documents10

✦ Starting with a template from the Microsoft Web site: Click the
Templates Home Page hyperlink on the New Document task pane to
go to Microsoft.com and choose a template there.

Speedy Ways to Open Documents
Rooting around in the Open dialog box to find a document is a bother, so
Word offers these handy techniques for opening documents:

✦ File menu: If you want to open a document you worked on recently, it
may be on the File menu. Check it out. Open the File menu and see
whether the document you want to open is one of those listed at the
bottom of the menu. If it is, click its name or press its number (1
through 4).

✦ Document list in New Document task pane: The same documents that
are listed on the File menu can also be found at the top of the New
Document task pane. Click a file there to open it.

✦ My Recent Documents button in the Open dialog box: Click the My
Recent Documents button in the Open dialog box to see a list of the last
three dozen documents and folders that you opened. Double-click a
document to open it; double-click a folder to see its contents.

✦ My Documents button in the Open dialog box: Click the My
Documents button to see the contents of the My Documents folder.
Double-click a document to open it. The My Documents folder is a good
place to keep documents you are currently working on. When you’re
done with a current document, you can move it to a different folder for
safekeeping.

✦ Windows Documents menu: Click the Start button and choose
Documents to see a list of the last 15 files you opened (in Word and in
other programs). Choose a Word document on the list to open it in
Word.

✦ Open the Recent Documents Menu: Click the Start button, choose My
Recent Documents, and select from the last several files you opened.
This way, you open a file and a program at the same time.

To list more than four documents at the bottom of the File menu and the top
of the New Document task pane, choose Tools➪Options, select the General
tab in the Options dialog box, and enter a number higher than 4 in the
Recently Used File List box.
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The New Document task pane appears when you start Word, but if you
prefer not to see it when you start the program, choose Tools➪Options,
select the View tab in the Options dialog box, and uncheck the Startup Task
Pane check box.

All about Saving Documents
Everybody, or nearly everybody, knows how to save a document. All you
have to do is press Ctrl+S, click the Save button, or choose File➪Save. The
first time you save a document, you are asked to give it a descriptive name
and choose the folder where it belongs. Word also offers the File➪Save As
command for saving a file under a different name. You can also save versions
of a document or save documents under a different format. Better read on.

Saving versions of documents
In a lengthy document such as a manual or a report that requires many
drafts, saving different drafts can be helpful. That way, if you want to
retrieve something that got dropped from an earlier draft, you can do so.
One way to save drafts of a document is to save them under different
names, but why do that when you can rely on the Versions command on the
File menu?

Follow these steps to save different versions of a document as it evolves
into a masterpiece:

1. Choose File➪Versions.

The Versions In dialog box appears, as shown in Figure 1-3. It lists past
versions of the document that you saved.

Figure 1-3:
Saving
different
versions of
a document.
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2. Click the Save Now button.

3. In the Save Version dialog box, write a descriptive comment about
this version of the document and click OK.

To review an earlier version of a document, choose File➪Versions. In the
Versions In dialog box, read comments to find the version you want to open,
select the version, and click the Open button. The earlier version appears in
its own window next to the up-to-date version. You can tell which version
you are dealing with by glancing at the title bar, which lists the date that the
earlier version was saved. If a version of a document deserves to be a docu-
ment in its own right, open it, choose File➪Save As, and save it under its own
name. That way, you can get at it more easily.

Saving under a different file format
Suppose that a friend or co-worker isn’t as sophisticated as you and doesn’t
have the latest version of Word. All is not lost: You can save Word docu-
ments under different formats and thereby permit others to open them. To
save under a different format, choose File➪Save As, open the Save As Type
drop-down list in the Save As dialog box, and choose a format. You will find
many formats on the Save As Type drop-down list, including earlier versions
of Word (97– 2002 and 6.0/95, as well as Rich Text Format), WordPerfect, and
Macintosh formats. I should warn you, however, that converting a file to a
different format is always a dicey proposition, because little things such as
special characters often get mangled in the translation.

Word also offers the Batch Conversion Wizard for converting numerous files
to a different format simultaneously. To use this wizard, start by creating a
new folder and copying files you want to convert to the folder. While you’re
at it, create a new folder for storing the converted files. The Batch Conversion
Wizard will ask you which files to convert and where to place the converted
files. By creating the two folders to begin with, you can make the process go
more smoothly. To run the Batch Conversion Wizard:

1. Choose File➪New and select the On My Computer hyperlink in the
New Document task pane.

Press Ctrl+F1 or choose View➪Task Pane to display the task pane.

2. In the Templates dialog box, select the Other Documents tab.

3. Double-click the Batch Conversion icon.

The Conversion Wizard starts. You will be asked to declare which
format you want to convert to or from, where the to-be-converted files
are located, which files need converting, and where to place the con-
verted files.
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If everybody you work with is running an older version of Word and you
want to save all your Word files under an older format, you can arrange to
save files this way automatically. Choose Tools➪Options, select the Save tab
in the Options dialog box, and choose a format from the Save Word Files As
drop-down list.

Changing the Font and Size of Text
Font is the catch-all name for type style and type size. When you change
fonts, you choose another style of type or change the size of the letters.
Word offers a whole bunch of different fonts. You can see their names by
clicking the down arrow next to the Font drop-down list and scrolling down
the list. To change the font:

1. Select the text or place the cursor where you want the font to change.

2. Click the down arrow on the Font drop-down list and select a font
name.

As shown in Figure 1-4, you see the names of fonts, each one dressed up
and looking exactly like itself. Word puts all the fonts you’ve used so far
in the document at the top of the Font drop-down list to make it easier
for you to find the fonts you use most often.

To quickly scroll down the list, press a letter on your keyboard. Press S,
for example, to scroll to fonts whose names begin with an S. Fonts with
TT beside their names are TrueType fonts. Use these fonts if you can
because they look the same on-screen as they do when printed on
paper.

Book IX, Chapter 1 explains how to load and unload fonts from your
computer. Unload fonts when the Font menu gets too crowded.

Choose a font.

Choose a point size.
Figure 1-4:
Choosing a
font and font
size.
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Type is measured in points. A point is 1⁄72 of an inch. The larger the point size,
the larger the letters. To change the size of letters:

1. Select the letters or place the cursor where you want the larger or
smaller letters to start appearing.

2. Click the down arrow on the Font Size drop-down list and choose a
Font size.

Enter a point size in the Font Size box if the font sizes on the menu don’t
do the trick.

You can also change font sizes by selecting the text and pressing
Ctrl+Shift+< or Ctrl+Shift+>. Doing so increases or decreases the font size by
the next interval on the Font Size menu. Press Ctrl+] or Ctrl+[ to increase or
decrease the font size by 1 point.

To change fonts and font sizes at the same time, choose Format➪Font and
make your choices in the Font dialog box.

Changing lowercase to UPPERCASE and Vice Versa
What do you do if you look at your screen and discover — to your
dismay — that you entered characters iN tHe wRONg casE! It happens.
And sometimes Word does mysterious things to letters at the start of sen-
tences and to capital letters in the middle of words. What can you do about
that? You can fix uppercase and lowercase problems in two ways.

Constructing your default document
When you open a brand-new document by
clicking the New Blank Document button or
pressing Ctrl+N, does the document meet your
specifications? When you start typing, does the
text appear in your favorite font? Are the mar-
gins just-so?

You can get a head start in creating documents
by telling Word what you want new docu-
ments to look like. To do that, open the Font 

dialog box (choose Format➪Font), the Page 
Setup dialog box (choose File➪Page Setup),
and the Language dialog box (choose Tools➪
Language➪Set Language), in turn, make your
choices, and click the Default button in these
dialog boxes. Changes you make this way 
are made to the Normal document template
(Chapter 4 explains what templates are).
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The fastest way is to select the text you entered incorrectly and press
Shift+F3. Keep pressing Shift+F3 until the text looks right. Shift+F3 first
changes the characters to all lowercase, then to Initial Capitals, then to ALL
UPPERCASE, and then back to all lowercase again.

Microsoft Weird is very presumptuous about how it thinks capital letters
should be used. You’ve probably noticed that already. You can’t type a 
lowercase letter after a period without Word uppercasing it. You can’t enter
lowercase computer code at the start of a line without Word capitalizing the
first letter. If Word capitalizes a letter against your will, move the pointer over
the letter. You see the AutoCorrect Options button. At that point, you can
click the button to open a drop-down menu and choose an option to undo the
capitalization. For that matter, you can click the Control AutoCorrect Options
command to open the AutoCorrect dialog box and choose for yourself what is
“corrected” automatically (Chapter 2 explains the AutoCorrect options).

Spell-Checking a Document
Don’t trust the smell checker — it can’t catch all misspelled words. If you
mean to type middle but type fiddle instead, for example, the spell-checker
won’t catch the error because fiddle is a legitimate word. The moral is: If
you’re working on an important document, proofread it carefully. Don’t rely
on the spell checker to catch all your smelling errors.

The spell-checker is great, however, for taking care of the majority of
spelling errors. Figure 1-5 demonstrates the two ways to run the spell-
checker. Red wiggly lines appear under words that Microsoft Word thinks
are misspelled. Right-click a misspelled word and choose the correct word
on the shortcut menu. Otherwise, go the whole hog and spell- or grammar-
check an entire document or text selection by starting in one of these ways:

✦ Click the Spelling and Grammar button.

✦ Choose Tools➪Spelling and Grammar.

✦ Press F7.

The Spelling and Grammar dialog box appears. Options in this dialog box
are self-explanatory, I think, except for these beauties:

✦ Ignore Once: Ignores the misspelling, but stops on it again if it appears
later in the document.

✦ Ignore All: Ignores the misspelling wherever it appears in the docu-
ment. Not only that, it ignores the misspelling in all your other open
documents.
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✦ Add to Dictionary: Adds the word in the Not in Dictionary box to the
words in the dictionary that Microsoft Word deems correct. Click this
button the first time that the spell checker stops on your last name to
add your last name to the spelling dictionary.

✦ Change All: Changes not only this misspelling to the word in the
Suggestions box, but also all identical misspellings in the document.

✦ AutoCorrect: Adds the suggested spelling correction to the list of words
that are corrected automatically as you type them (Chapter 2 explains
the AutoCorrect mechanism).

✦ Undo: Goes back to the last misspelling you corrected and gives you a
chance to repent and try again.

✦ Check Grammar: Uncheck this box to run the spell checker and ignore
what Word thinks are grammatical errors.

You can click outside the Spelling dialog box and fool around in your docu-
ment, in which case the Ignore button changes names and becomes
Resume. Click the Resume button to start the spell-check again.

Suppose that you have a bunch of computer code or French language text
that you would like the spell checker to either ignore or check against its
French dictionary instead of its English dictionary. To tell the spell checker
how to handle text like that, select the text and choose Tools➪Language➪
Set Language. In the Language dialog box, choose a new language for your
words to be spell-checked against, or else click the Do Not Check Spelling or
Grammar check box.

Figure 1-5:
Two ways to
fix spelling
errors.
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From Word’s standpoint, a dictionary is merely a list of words in a file, not a
list of words and their definitions. To find spelling errors, Word compares
each word on the page to the words in its main dictionary (Mssp3en.lex, if
you write in U.S. English) and a second dictionary called Custom.dic. The
Custom.dic dictionary lists words, proper names, and technical jargon that
you deemed legitimate when you clicked the Add to Dictionary button in the
course of a spell check. To edit a custom dictionary, choose Tools➪Options,
select the Spelling & Grammar tab in the Options dialog box, click the Custom
Dictionaries button, select the dictionary that needs editing in the Custom
Dictionaries dialog box, and click the Modify button. A dialog box appears
with all the words in the dictionary in a list. Edit away.

What’s with the red and green wiggly lines?
As you must have noticed by now, red wiggly
lines appear under words that are misspelled,
and green wiggly lines appear under words and
sentences that Word thinks are grammatically
incorrect. Correct spelling and grammar errors
by right-clicking them and choosing an option
from the shortcut menu. If the red or green lines
annoy you, however, you can remove them from
the screen by choosing Tools➪Options and
selecting the Spelling & Grammar tab in the
Options dialog box:

✦ Stop the wiggly lines from appearing:
Unselect the Check Spelling as You Type and
Check Grammar as You Type check boxes.

✦ Stop the lines from appearing in one docu-
ment only: Select the Hide Spelling Errors
in This Document or Hide Grammatical
Errors in this Document check boxes.
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